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1.1. About Stellar Converter for Outlook 

Stellar Converter for Outlook converts mails from MS Outlook PST file to MBOX file. User can open the converted 

MBOX files in Thunderbird, Spicebird, SeaMonkey or Netscape as per user selection. After scanning, the software shows 

the preview of mails. 

Key Features of Stellar Converter for Outlook 

 Support for updated Mozilla Thunderbird. 

 User friendly and secure software. 

 Converts Outlook PST files to Thunderbird files. 

 Converts Outlook PST files to Spicebird files. 

 Converts Outlook PST files to SeaMonkey files. 

 Converts Outlook PST files to Netscape files. 

 Converts password protected PST files. 

 Provides preview of mails. 

 Provides Log Report. 

 Supports MS Office 2019, 2016, 2013, 2010 



 

1.2. About the Guide 

This user guide contains sequential steps to assist you through various Stellar Converter for Outlook functions. Each 

function is explained in details, in the corresponding sections. The guide covers following major topics: 

1. General Information 

2. Getting Started 

3. Working with the Software 

4. Frequently Asked Questions (FAQ) 

This guide has the following features for easy navigation and understanding : 

 There are Notes and Tips in some topics of this guide for better understanding and ease of work. These Notes 

and Tips are given in italics style. 



1.3. Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

You can either call us or go online to our support section at https://www.stellarinfo.com/support/   

For price details and to place the order, click https://www.stellarinfo.com/email-tools/pst-to-mbox-converter/buy-now.php  

Chat Live with an Online technician at https://stellarinfo.com  

Search in our extensive Knowledge Base at https://www.stellarinfo.com/support/kb/  

Submit enquiry at https://www.stellarinfo.com/support/enquiry.php  

E-mail to Stellar Support at support@stellarinfo.com  

  

  

https://www.stellarinfo.com/support/
https://www.stellarinfo.com/email-tools/pst-to-mbox-converter/buy-now.php
https://www.stellarinfo.com/
https://www.stellarinfo.com/support/kb/
https://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com.


 

1.4. Legal Notices 

Copyright 

Stellar Converter for Outlook software, accompanied user manual and documentation are copyright of Stellar 

Information Technology Private Limited, with all rights reserved. Under the copyright laws, this user manual cannot be 

reproduced in any form without the prior written permission of Stellar Information Technology Private Limited. No Patent 

Liability is assumed, however, with respect to the use of the information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject to change 

without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH REGARD TO THIS 

MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY EXPRESSLY DISCLAIMS ANY 

IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE WITH REGARD 

TO ANY OF THE FOREGOING STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO 

LIABILITY FOR ANY DAMAGES INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR 

TYPOGRAPHICAL ERRORS OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE 

PRODUCT AND THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, WHETHER BASED 

ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION WITH THIS MANUAL OR ANY 

OTHER INFORMATION CONTAINED HEREIN OR THE USE THEREOF. 

 

Trademarks 

Stellar Converter for Outlook® is a registered trademark of Stellar Information Technology Private Limited. 

Windows 7®, Windows 8®, Windows 8.1®, Windows 10®, are registered trademarks of Microsoft® Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective companies. 



END USER LICENSE AGREEMENT 

PLEASE READ THIS AGREEMENT CAREFULLY. BY DOWNLOADING, INSTALLING, COPYING, ACCESSING OR 

USING THIS SOFTWARE, ALL OR ANY PORTION OF THIS SOFTWARE, YOU (HEREINAFTER “CUSTOMER”) 

ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT WHICH WILL BIND YOU. THE TERMS OF THIS 

LICENSE INCLUDE, IN PARTICULAR, LIMITATIONS ON LIABILITY CLAUSE. 

IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, WE WILL NOT LICENSE THE SOFTWARE AND 

DOCUMENTATION TO YOU AND YOU MUST DISCONTINUE THE INSTALLATION PROCESS NOW, AND 

PROMPTLY RETURN THE SOFTWARE AND PROOF OF ENTITLEMENT TO THE PARTY FROM WHOM YOU 

ACQUIRED THE SOFTWARE. 

1. DEFINITIONS. 

1.1 “Stellar” means Stellar Information Technology Pvt. Ltd., having its registered office at 205, Skipper Corner, 88, 

Nehru Place, New Delhi, India 110019. 

1.2 “Compatible Computer” means a Computer with the recommended operating system and hardware configuration as 

stated in the Documentation. 

1.3 “Computer” means a virtual or physical device that accepts information in digital or similar form and manipulates it for 

a specific result based on a sequence of instructions, including without limitation desktop computers, laptops, tablets, 

mobile devices, telecommunication devices, Internet-connected devices, and hardware products capable of operating a 

wide variety of productivity, entertainment, or other software applications. 

1.4 “Customer” means you and any legal entity that obtained the Software and on whose behalf it is used; for example, 

and as applicable, your employer. 

1.5 “Permitted Number” means one (1) unless otherwise indicated under a valid license (e.g., volume license) granted 

by Stellar. 

1.6 “Software” means (a) all of the information with which this agreement is provided, including but not limited to: (i) all 

software files and other computer information; (ii) any proprietary scripting logic embedded within exported file formats 

(iii)images, sounds, clip art, video and other works bundled with Stellar software or made available by Stellar on Stellar’s 

website for use with the Stellar software and not obtained from Stellar through a separate service (unless otherwise noted 

within that service) or from another party (“Content Files”); (iv) related explanatory written materials and files 

(“Documentation”); and (v) any modified versions and copies of, and upgrades, updates, and additions to, such 



 

information, provided to Customer by Stellar at any time, to the extent not provided under separate terms (collectively, 

“Updates”). 

2. LICENSE GRANT; PROPRIETARY RIGHTS 

Right to use the Software: Subject to the terms and conditions of this Agreement, Stellar grants Customer a non-

exclusive, non-transferable right, revocable and limited license to access and use the Software and Documentation on a 

single computer or workstation in a single location for your personal purposes (if you are a consumer) or your internal 

business purposes (if you are a business user) subject to the terms stated below. Customer must use the Technician 

License if using the software to provide professional or paid service to a third party (individual or company) and / or for 

any commercial purposes. 

SINGLE USER LICENSE. The term means a SOFTWARE that may be installed and used only by a single USER on a 

single computer at any one time. Consequently, the SOFTWARE must not be installed, displayed, shared or used 

concurrently from the computer or on distinct computers. Single User License is granted to customer who is using 

STANDARD, PROFESSIONAL, PREMIUM or CORPORATE Edition of the Software. 

MULTIPLE USER LICENSE. The term means a SOFTWARE that may be installed and used by a specified number of 

USERS representing an equivalent number of computers. The SOFTWARE must not be installed, displayed, shared or 

used from or on a number of computers greater than the number of workstations authorized. Multiple User License are 

associated with Technician & Toolkit Edition of the Software. MAXIMUM Installation and usage limit of this License in on 3 

Computers. 

3. LICENSE TYPES 

3.1 Evaluation Software/Trial version: The Software is provided with or without License key which can be downloaded 

for free from Stellar’s website. The Software may only be installed and used on Permitted Number of Compatible 

Computers during the License Term for demonstration, evaluation, and training purposes only. Evaluation Software or 

Trial version of the Software may be freely distributed, if the distribution package is not modified. No person or company 

may charge a fee for the distribution of trial version without written permission from the copyright holder. 

3.2 Subscription License: For the Software available on a subscription-basis (“Subscription License”), Customer may 

install and use the Subscription License only on the Permitted Number of Compatible Computer during the License Term 

Period. Subject to the Permitted Number of Computers for the Subscription License, Customer agrees that Stellar may 

change the type of Software (such as specific components, versions, platforms, languages, etc.) included in the 



Subscription License at any time and shall not be liable to the Customer whatsoever for such change. Ongoing access to 

a Subscription License requires a recurring Internet connection to activate, renew, and validate the license. If Stellar does 

not receive the recurring subscription payment or cannot validate the license periodically, then the Software may become 

inactive without additional notice until Stellar receives the payment or validates the license. 

3.3 Lifetime License: Once registered, user is granted an exclusive license to use the Software for maximum period of 

10 years on the same computer with same configuration and operating system which is compatible with the software. If 

the computer hardware or software is changed during the lifetime of the license which is not compatible with the original 

purchased version; then user may need to additionally purchase the upgraded version of the software. 

4. SOFTWARE SUPPORT. 

Support will only be provided to only license customer for a period of 1 Year from the date of purchase. Queries regarding 

the installation and use of the software should be submitted by e-mail which get responded usually within 24 Business 

Hours. 

Free Technical Support is provided for 1 Year from the date of purchase, if your license term is greater than 1 year then 

you may avail Technical Support by paying additional fee applicable at that time. Paid support can be purchased for 

Lifetime License only upto a maximum period of next 2 years. Stellar will not assist customers for any support request 

related to the Software after 3 years from the purchase of the software. 

5. INTELLECTUAL PROPERTY OWNERSHIP. 

The Software and any authorized copies that Customer makes are the intellectual property of and are owned by Stellar. 

The structure, organization, and source code of the Software are the valuable trade secrets and confidential information of 

Stellar Information Technology Pvt. Ltd. The Software is protected by law, including but not limited to the copyright laws of 

the United States and other countries, and by international treaty provisions. Except as expressly stated herein, this 

agreement does not grant Customer any intellectual property rights in the Software. All rights not expressly granted are 

reserved by Stellar. 

6. RESTRICTIONS & REQUIREMENTS. 

6.1 Proprietary Notices. Any permitted copy of the Software (including without limitation Documentation) that Customer 

makes must contain the same copyright and other proprietary notices that appear on or in the Software. 

6.2 Use Obligations. Customer agrees that it will not use the Software other than as permitted by this agreement and that 

it will not use the Software in a manner inconsistent with its design or Documentation. 



 

6.3 No Modifications. Customer shall not modify, adapt, tamper with, translate or create Derivative Works of the Software 

or the Documentation; combine or merge any part of the Software or Documentation with or into any other software or 

documentation; or refer to or otherwise use the Software as part of any effort to develop software (including any routine, 

script, code, or program) having any functional attributes, visual expressions or other features similar to those of the 

Software to compete with Stellar; 

except with Stellar’s prior written permission, publish any performance or benchmark tests or analysis relating to the 

Software; 

6.4 No Reverse Engineering. Customer shall not reverse engineer, decompile, disassemble, or otherwise attempt to 

discover the source code of the Software. 

6.5 No Unbundling. The Software may include various applications and components, may allow access to different Stellar 

Online Channels, may support multiple platforms and languages, and may be provided to Customer on multiple media or 

in multiple copies. Nonetheless, the Software is designed and provided to Customer as a single product to be used as a 

single product on Computers as permitted herein. Unless otherwise permitted in the Documentation, Customer is not 

required to install all component parts of the Software, but Customer shall not unbundle the component parts of the 

Software for use on different Computers. 

6.6 Customer will not remove, erase, obscure or tamper with any copyright or any other product identification or 

proprietary rights notices, seal or instructional label printed or stamped on, affixed to, or encoded or recorded in or on any 

Software or Documentation; or fail to preserve all copyright and other proprietary notices in all copies Company makes of 

the Software and Documentation; 

6.7 Customer will not run or operate the Software in a cloud, Internet-based computing or similar on-demand computing 

environment unless Company’s Grant Letter or the applicable Product Entitlement Definitions specifically allows the use. 

6.8 No Transfer. Customer will not rent, lease, sell, sublicense, assign, or transfer its rights in the software (including 

without limitation, software obtained through a web download), or authorize any portion of the software to be copied onto 

another individual or legal entity’s computer except as may be expressly permitted herein. 

7. COPYRIGHT/OWNERSHIP. 

Customer acknowledges that all intellectual property rights in the Software and the Documentation anywhere in the world 

belong to, or are licensed to Stellar.  The rights granted to you in the Software are licensed (not sold), and you have no 

rights in, or to, the Software or the Documentation other than the right to use them in accordance with the terms of 

this License. The Software, its source code and Documentation are proprietary products of Stellar Information Technology 



Pvt. Ltd. (“Stellar”) to provide the License and are protected by copyright and other intellectual property laws. Stellar shall 

at all times retain all rights, title, interest, including intellectual property rights, in the Software or Documentation. 

8. WARRANTIES. 

The licensed software (excluding the media on which it is distributed) and all Stellar related websites and services are 

provided to licensee ‘AS IS’ and “AS AVAILABLE,” and Stellar and its suppliers and licensors make NO WARRANTY as 

to their use or performance. Stellar and its suppliers and licensors make NO WARRANTIES OR REPRESENTATIONS 

(express or implied, whether by statute, common law, custom, usage, or otherwise) as to any matter including without 

limitation to quality, availability, performance or functionality of the licensed software or any related Stellar websites or 

services; quality or accuracy of any information obtained from or available through use of the licensed software or related 

Stellar websites or services; any representation or warranty that the use of the licensed software or any related Stellar 

websites or services will be uninterrupted or always available (whether due to internet failure or otherwise), error-free, free 

of viruses or other harmful components or operate on or with any particular hardware, platform or software; non-

infringement of third-party rights, merchantability, integration, satisfactory quality, or fitness for any particular purpose, 

except for, and only to the extent, that a warranty may not be excluded or limited by applicable law in licensee’s 

jurisdiction. 

9. DATA PROTECTION.  

You understand that by using the Licensed Software, you consent and agree to the collection and use of certain 

information about you and your use of the Licensed Software in accordance with Stellar’s Privacy Policy. You further 

consent and agree that Stellar may collect, use, transmit, process and maintain information related to your Account, and 

any devices or computers registered thereunder, for purposes of providing the Licensed Software, and any features 

therein, to you. Information collected by Stellar when you use the Licensed Software may also include technical or 

diagnostic information related to your use that may be used by Stellar to support, improve and enhance Stellar’s products 

and services. For more information please read our full privacy policy at “https://www.stellarinfo.com”, on the section 

Privacy Policy. You further understand and agree that this information may be transferred to the United States, India 

and/or other countries for storage, processing and use by Stellar, its affiliates, and/or their service providers. You hereby 

agree and consent to Stellar’s and its partners’ and licensors’ collection, use, transmission, processing and maintenance 

of such location and account data to provide and improve such features or services. 

 

 

https://www.stellarinfo.com/


 

10. INTERNET CONNECTIVITY & PRIVACY. 

10.1 Automatic Connections to the Internet. The Software may cause Customer’s Computer, without notice, to 

automatically connect to the Internet and to communicate with Stellar website or Stellar domain for purposes such as 

license validation and providing Customer with additional information, features, or functionality. Unless otherwise specified 

in Sections 10.2 through 10.5, the following provisions apply to all automatic Internet connections by the Software: 

10.1.1 Whenever the Software makes an Internet connection and communicates with a Stellar website, whether 

automatically or due to explicit user request, the Privacy Policy shall apply. Stellar Privacy Policy allows tracking of 

website visits and it addresses in detail the topic of tracking and use of cookies, web beacons, and similar devices. 

10.1.2 Whenever the Software connects to Stellar over the Internet, certain Customer information is collected and 

transmitted by the Software to Stellar pursuant to the Stellar Online Privacy Policy available 

at https://www.stellarinfo.com/ under Privacy Policy section. 

10.1.3 If Customer accesses Stellar Online Service or activates or registers the Software, then additional information such 

as Customer’s ID, user name, and password may be transmitted to and stored by Stellar pursuant to the Privacy Policy 

and additional terms of use related to such Stellar Online Service. 

10.1.4 Stellar, unless barred under applicable law, may (a) send Customer transactional messages to facilitate the Stellar 

Online Service or the activation or registration of the Software or Stellar Online Service, or (b) deliver in-product marketing 

to provide information about the Software and other Stellar products and Services using information including but not 

limited to platform version, version of the Software, license status, and language. 

10.2 Updating. The Software may cause Customer’s Computer, without additional notice, to automatically connect to the 

Internet (intermittently or on a regular basis) to (a) check for Updates that are available for download to and installation on 

the Computer and (b) notify Stellar of the results of installation attempts. 

10.3 Activation. The Software may require Customer to (a) obtain Stellar Software Activation Key, (b) activate or 

reactivate the Software, (c) register the software, or (d) validate the Ownership. Such requirement may cause Customer’s 

Computer to connect to the Internet without notice on install, on launch, and on a regular basis thereafter. Once 

connected, the Software will collect and transmit information to Stellar. Software or Customer may also receive 

information from Stellar related to Customer’s license, subscription, or Ownership. Stellar may use such information to 

detect or prevent fraudulent or unauthorized use not in accordance with a valid license, subscription, or Ownership. 

Failure to activate or register the Software, validate the subscription or Ownership, or a determination by Stellar of 

https://www.stellarinfo.com/


fraudulent or unauthorized use of the Software may result in reduced functionality, inoperability of the Software, or a 

termination or suspension of the subscription or Ownership. 

10.4 Use of Online Services. The Software may cause Customer’s Computer, without additional notice and on an 

intermittent or regular basis, to automatically connect to the Internet to facilitate Customer’s access to content and 

services that are provided by Stellar or third parties. In addition, the Software may, without additional notice, automatically 

connect to the Internet to update downloadable materials from these online services so as to provide immediate 

availability of these services even when Customer is offline. 

10.5 Digital Certificates. The Software uses digital certificates to help Customer identify downloaded files (e.g., 

applications and/or content) and the publishers of those files. For example, Stellar uses digital certificates to help 

Customer identify the publisher of Stellar applications. Customer’s Computer may connect to the Internet at the time of 

validation of a digital certificate. 

11. LIMITATION OF LIABILITY 

In no event shall Stellar or its suppliers be liable for any special, incidental, indirect, or consequential damages 

whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business 

information, or any other pecuniary loss) arising out of the use of or inability to use the software product or the provision of 

or failure to provide support services, even if Stellar has been advised of the possibility of such damages. In any case, 

Stellar’s entire liability under any provision shall be limited to the amount actually paid by you for the software product or a 

sum of US Dollars Five whichever is higher. 

12. TERMINATION       

If Customer breaches this EULA, and fails to cure any breach within 30 calendar days after request from Stellar, Stellar 

may terminate this EULA, whereupon all rights granted to Customer shall immediately cease including but not limited to 

the license granted to the customer to use the software which shall also stand revoked. Furthermore, upon termination, 

Customer shall return to Stellar all copies of the Licensed Software, or verify in writing that all copies of the Licensed 

Software have been destroyed and failure of the customer  to do so would entitle Stellar to sue for relief in equity and 

damages. 

13. JURISDICTION AND LAW 

13.1 This EULA is subject to, and will be governed by and construed in accordance with the substantive laws applicable to 

the state of Delhi (India). Courts at Delhi, India alone shall have the jurisdiction to entertain any dispute arising out of the 

terms and conditions of this EULA and you consent to such jurisdiction of the courts at Delhi, India. 



 

13.2 This EULA will not be governed by the conflict of law rules of any jurisdiction, or the United Nations Convention on 

Contracts for the International Sale of Goods, the application of which is expressly excluded. 

14. GENERAL 

14.1 This License is the complete statement of the agreement between the parties on the subject matter and merges and 

supersedes all other or prior understandings, purchase orders, agreements and arrangements. 

14.2 The exclusions of warranties and liability limitations shall survive the termination of this EULA, howsoever caused; 

but this survival shall not imply or create any continued right to use the Licensed Software after termination of this EULA. 

14.3 Licensee shall not ship, transfer, or export Licensed Software into any country or use Licensed Software in any 

manner prohibited by the applicable export control laws, notably where applicable, the United States Export 

Administration Act, restrictions, or regulations (collectively the 'Export Laws'.) All rights to use the Licensed Software are 

granted on condition that Licensee complies with the Export Laws, and all such rights are forfeited if Licensee fails to 

comply with the Export Laws. 

14.4 Stellar reserves all rights not expressly granted to Licensee by this EULA All rights are reserved under the copyright 

laws of India and/or of other countries, to Stellar Information Technology Pvt Ltd, having its registered office at 205, 

Skipper Corner, 88, Nehru Place, New Delhi, India 110019. 

14.5 There are no third party beneficiaries of any promises, obligations or representations made by Stellar herein. 

14.6 Any waiver by Stellar of any violation of this License by you shall not constitute nor contribute to a waiver by Stellar 

of any other or future violation of the same provision or any other provision of this License. 

14.7 This EULA constitutes the entire agreement between you and Stellar and it supersedes all prior or contemporaneous 

representations, discussions, undertakings, communications, agreements, arrangements, advertisements, and 

understandings regulating the Licensed Software. This EULA is binding on and made for the benefit of the parties and 

their successors and permitted assigns. 

14.8 This EULA may only be modified, supplemented or amended by a writing signed by an authorized officer of Stellar. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 



1.5. About Stellar 

is the world's foremost Data Care Corporation, with expertise in Data Recovery, Data Erasure, Mailbox 

Conversion, and File Repair software and services. Stellar has been in existence from past 25+ years and is a customer-

centric, critically acclaimed, global data recovery, data migration & erasure solutions provider with cost-effective solutions 

available for large corporate, SMEs & Home Users. Stellar has a strong presence across USA, Europe & Asia. 

Product Line: 

Stellar provides a wide range of Do It Yourself (DIY) Software for Consumer as well as Software for Businesses: 

 

Data Recovery 

 

File Repair 

 

Data Erasure 

 

The widest range of data recovery 

software that helps you recover your 

valued data lost after accidental format, 

virus problems, software malfunction, 

file/directory deletion, or even 

sabotage! 

The most comprehensive range of file 

repair software for Windows, Mac and 

Linux. Recover your files, which have 

been infected by viruses, malwares or 

have been damaged by improper 

shutdown and other corruption-related 

issues. 

Best software for IT assets disposition. 

Secure and erase variety of storage 

media and files from PC/Laptop, 

Servers, Rack Drives or Mobile 

devices. Data once erased cannot be 

recovered by using any data recovery 

software or service. 

 

 

 

 

 

 

Email Repair & Converter 

 

Database Repair 

 

Email Backup Tools 

 
Robust applications to restore 

inaccessible mailboxes of MS 

Exchange, Outlook, AppleMail, 

Thunderbird, Eudora, Spicebird, 

Entourage, and Pocomail mailbox. 

Also, tools to convert mailboxes 

and database files from one 

format to another. 

Professional and reliable software 

to repair corrupt or damaged 

database for Microsoft SQL 

Server, QuickBooks®, Microsoft 

Access, SQLite and many more. 

Fully featured backup utilities that 

provides a comprehensive 

solution in case of any disaster. 

These software facilitates taking 

back up of all your mails, 

contacts, tasks, notes, calendar 

entries, journals etc. with full & 

incremental backup options. 

 

 

 

 

 

 



 

Photo and Video Tools 

 

Utility Tools 

 

Stellar Toolkits 

 

Professional tools to rebuild 

damaged or corrupt photos, videos, 

audios, and other multimedia files, 

from Window and Mac systems. 

Recover files from hard drives, 

memory cards, iPods, USB flash 

drives, digital cameras, IBM Micro 

Drives and more. 

A range of utility software such as 

SpeedUp Mac, Drive Clone and 

Partition Manager for Mac systems 

as well as Password Recovery for 

Windows and Password Recovery 

for Windows Server based systems 

Stellar also provides toolkits that are 

combination of Powerful Tools 

Designed for Data Recovery, File 

repair, Mailbox repair and File 

Conversion. All in one power packed 

toolkits to meet the need of every 

business. 

 

 

 

 

 

 

For more information about us, please visit www.stellarinfo.com. 

http://www.stellarinfo.com/
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2.1. Installation Procedure 

Before beginning the installation procedure, make sure that the computer meets the minimum system requirements. 

Minimum System Requirements: 

 Processor: Intel Pentium Class 

 Operating system:  Windows 10 / 8.1 / 8 / 7  

 Hard Disk: At least 250 MB of free disk space 

 RAM: 2 GB minimum (4 GB recommended) 

 MS Outlook: 2019, 2016, 2013, 2010 

  

To Install the Software: 

 Double-click StellarConverterforOutlook.exe executable file to start installation. Setup - Stellar Converter for 

Outlook dialog box is displayed. 

 Click Next. License Agreement dialog box is displayed. 

 Choose I accept the agreement option. Next button will be enabled. Click Next. Select Destination Location 

dialog box is displayed. 

 Click Browse to select the destination path where the setup files will be stored. Click Next. Select Start Menu 

Folder dialog box is displayed. 

 Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog box is 

displayed. 

 Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed. 

 Review the entries. Click Back if you want to change them. Click Install to start installation. The Installing window 

shows the installation process. 

 After completing the process, Completing the Stellar Converter for Outlook Setup Wizard window is 

displayed. Click Finish. 

Note: Clear Launch Stellar Converter for Outlook check box before clicking Finish to prevent the software from 

launching. 

  

 

 

 

 



2.2. Launching the Software 

To launch Stellar Converter for Outlook in Windows 10: 

 Click Start icon -> All apps -> Stellar Converter for Outlook  -> Stellar Converter for Outlook  Or, 

 Double click Stellar Converter for Outlook icon on the desktop. Or, 

 Click Stellar Converter for Outlook tile on the home screen. 

To launch Stellar Converter for Outlook in Windows 8.1 / 8: 

 Click Stellar Converter for Outlook tile on the home screen. Or, 

 Double click Stellar Converter for Outlook icon on the desktop. 

To launch Stellar Converter for Outlook in Windows 7: 

 Click Start -> Programs -> Stellar Converter for Outlook -> Stellar Converter for Outlook. Or, 

 Double click Stellar Converter for Outlook icon on the desktop. Or, 

 Click Stellar Converter for Outlook icon in Quick Launch. 



 

2.3. User Interface 

Stellar Converter for Outlook software has a very easy to use Graphical User Interface. The user interface contains 
features required for conversion. 
  
After launching the program, you will see the main user interface as shown below: 
  

 

  

The user interface contains menus and buttons that lets you access various features of the software with ease. 
  
The main user interface gives you two options to select PST files. You can either choose an existing Outlook profile by 
clicking on Select Outlook Profile and then select any profile from the available/listed profiles, or, you can click on Select 
Outlook PST File to select the MS Outlook PST file that you want to convert to MBOX. 
  
You can also search for PST files by clicking on Find PST File. 
  
Finally, specify the desired MBOX client in the Select Mail Client (MBOX) section and click OK to start the conversion 
process. 
  
If the selected file is password protected, the Enter Outlook PST Password dialog box is displayed as shown below. 
  

 
  
You will need to enter the password to start the conversion process. 



2.3.1. Menus 

1. File Menu 

 

 Select PST : Use this option to open Mail Clients & PST Details dialog box. 

 Convert to MBOX : Use this option to start the conversion process. 

 Exit : Use this option to exit the application. 

  

2. View Menu 

 

 View Log : Use this option to view the log report. 

  

3. Registration Menu 

 

 Register Stellar Converter for Outlook : Use this option to activate the product after purchasing. 

 Transfer License : Use this option to transfer the license of the registered software to another computer. 

  

4. Help Menu 

 

 Stellar Converter for Outlook Help : Use this option to see the user help guide. 

 Purchase Stellar Converter for Outlook : Use this option to buy Stellar Converter for Outlook. 

 Submit Enquiry : Use this option to submit enquiry to stellarinfo.com 

https://www.stellarinfo.com/email-tools/pst-to-mbox-converter/buy-now.php
https://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/support/enquiry.php


 

 View Knowledge Base : Use this option to visit the Knowledge Base articles of stellarinfo.com 

 View Support Section : Use this option to visit the support page of stellarinfo.com 

 About Stellar Converter for Outlook : Use this option to read information about the software.   

https://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/kb/
https://www.stellarinfo.com/support/
http://www.stellarinfo.com/support/


2.3.2. Buttons 

 

 

Select PST File 

Click this button to open Select Outlook Profile & MBOX Client dialog box. 

 

 

Convert to MBOX 

After scanning, click this button to go through the process of saving converted mails. 

 

 

Help 

Click this button to access the User Guide if you face any issue while using the product. 

 

 

Update Wizard 

Click this button to check for both, latest minor and major version available online. 

 

 

Purchase 

Click this button to go through the purchasing process. 

 

 

About 

Click this button to know the version of the software, operating systems it supports, service 

pack number of the operating system, etc. 

 



 

2.4. Ordering the Software 

Click https://www.stellarinfo.com/email-tools/pst-to-mbox-converter.php to know more about Stellar Converter for 

Outlook. 

To purchase the software online, please visit https://www.stellarinfo.com/email-tools/pst-to-mbox-converter/buy-now.php  

Alternatively, click Purchase button on the application tool bar to purchase the software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required to register the 

software. 

https://www.stellarinfo.com/email-tools/pst-to-mbox-converter.php
https://www.stellarinfo.com/email-tools/pst-to-mbox-converter/buy-now.php


2.5. Registering the Software 

The demo version is just for evaluation purpose and must be eventually registered to use the full functionality of the 

software. The software can be registered using the Registration Key which you will receive via email after purchasing the 

software. 

To register the software: 

1. Run demo version of Stellar Converter for Outlook software. 

2. On Registration menu, click Register option. Register window is displayed as shown below. 

 

3. Choose ’I don’t have the registration key’ (Use this option if you have not purchased the product) or select ’I have 

the registration key’ (Use this option if you have already purchased the product). 

  

To register the software, when you do not have a registration key, follow the steps given below: 

1. In the Register window, select 'I don't have the registration key' option. Click OK, to go online and purchase the 

product. 

2. Once the order is confirmed, a Registration Key will be sent to the email provided at the time of purchase. 

3. In the Online Registration window, type the Registration Key and click Register button (Please ensure that you 

have an active Internet connection). 

 



 

4. ' Activation Completed Successfully ' message is displayed after the process is completed successfully. Click OK. 

  

To register the software, when you have a key, follow the steps given below: 

1. In the Register window, select 'I have the registration key' option. 

2. You can choose either 'Online Registration' (Use this option to register the software over Internet) or 'Offline 

Registration' (Use this option to register the software manually / through e-mail if for any reason, Internet 

connection is unavailable). 

 Online Registration 

Online Registration is possible only when an active Internet connection is available. 

o To register the software online: 

1. From the Register window, select Online Registration. Click OK. 

 

2. An Online Registration dialog box will appear. 

3. Type the Registration Key (received through email after purchasing the product) in the field of 

Registration Key. Click Register. 

 

4. The software would automatically communicate with the license server to verify the entered key. If the key 

you entered is valid, software will be registered successfully. 



 Offline Registration 

Offline Registration enables you to register the product when your computer does not have an Internet connection. 

o To register the software offline: 

1. From the Register window, select Offline Registration. Click OK. 

 

2. An Offline Registration dialog box will appear displaying Registration ID in its respective field. 

 

3. To get your License Key, which is required to register the software manually, you need to mail the listed 

Registration ID to support@stellarinfo.com. 

4. A License Key will be sent to your email address after verifying the Registration ID and purchase details 

by Stellar Technical Support. 

5. After receiving the License Key, open Stellar Converter for Outlook. In Register window, select 'I have 

the registration key'. 

6. Select Offline Registration and click OK. 

7. Enter the License Key received through email in the field of License Key. 

mailto:support@stellarinfo.com


 

 

8. Click Register to activate the software. A confirmation message is displayed if a valid key is entered. Click 

OK. 



2.6. Transfer License 
 
Stellar Converter for Outlook allows you to transfer the license of the registered software to another computer on which 

you want to run the software with full functionality. This operation deactivates the product on your current computer so it 

can be reactivated on the new computer. 

To transfer a software license from one computer to another, please follow the specific steps below: 

On Target Computer: 

1. Run demo version of the software. 

2. In Registration Menu on Menu Bar, click Register. A new dialog appears. 

3. From the Register window, select Offline Registration. Click OK.   

4. An Offline Registration dialog box will appear displaying Registration ID in its respective field. 

           

  

On Source Computer: 

1. Run registered version of Stellar Converter for Outlook software. 

2. In Registration Menu on Menu Bar, click Transfer License. 

           

3. Copy the Registration ID displayed on the Target Computer in the field of Registration ID on the Source 

Computer. 



 

4. To get your License Key, click Transfer In button on Source Computer. This will generate a License Key. 

           

5. You can also save the License Key generated on the source computer. Click Save to File button to save the 

Registration ID and the License Key. In Browse for Folder dialog box, select the location where you want to save 

the details. Click OK. 

6. ' License Key has been saved successfully ' message is displayed after the saving process is completed 

successfully. Click OK. 

This will deactivate the product on Source Computer and you will no longer be able to use the software anymore on this 

computer. 

On Target Computer: 

1. Type the License Key which you have generated on the Source Computer in the provided field of License Key. 

           

2. Click Register to complete the activation process. 

3. ' Activation Completed Successfully ' message is displayed after the process is completed successfully. Click OK. 

  



2.7. Updating the Software 

There are periodical software updates for Stellar Converter for Outlook. The software updates should be done to keep 

the software up-to-date. The updates can be a newly added functionality, a new feature, a new service, or any other 

information that can be important for improvement. Update option in the application is capable of checking for the latest 

updates. This will check for both latest minor and major version available online. You can easily download minor version 

through the update wizard. However, the major version, if available, has to be purchased. While updating the software, it’s 

recommended to close all the running programs. Note that demo version can not be updated. 

To update the application, follow these steps: 

 Click on Update Wizard button in application tool bar. Update Wizard is displayed. 

 Click Next. A busy timer shows that updates are being searched. If it finds any new version, a message indicates 

it's availability. 

 If a message is displayed that no updates are available, Click Cancel to close the wizard. 

 Click Next. The software will start downloading the update files from the server. When the process is complete, 

the software will upgrade to the latest version. 



 

2.8. How to Uninstall the Software 

Stellar Converter for Outlook can be removed either by using Uninstall Stellar Converter for Outlook program in the 

software or from Add/Remove Programs in the Control Panel. 

To uninstall the application using Uninstall Stellar Converter for Outlook:   

 Click Start -> All Programs -> Stellar Converter for Outlook -> Uninstall Stellar Converter for Outlook. Follow 

the on screen instructions to completely remove the software, including registry entries from your computer. 

To uninstall the application using Control Panel: 

 Click Start -> Control Panel -> Add/Remove Programs. Select Stellar Converter for Outlook entry from the 

displayed list and click Change/Remove. Follow the on screen instructions to completely remove the software as 

well as registry entries from your computer. 



3. Working with the Software 
 

3.1. Select MS Outlook Profile/PST File 

3.2. Find PST Files 

3.3. Preview of Mails 

3.4. Save Converted Mails 

3.5. Import Converted MBOX Files 

3.6. View and Save Log Report 



 

3.1. Select MS Outlook Profile/PST File 

To select MS Outlook Profile/PST file: 

Launch Stellar Converter for Outlook. Select Outlook Profile & MBOX Client dialog box is displayed as shown below: 

 

  

 Select Outlook Profile & MBOX Client dialog box is also displayed when you 

 Choose Select PST File option in File menu. 

 Click Select PST File  button on the toolbar 

  

Once the Select Outlook Profile & MBOX Client dialog box is displayed, you can either select an existing outlook profile, 

or select an Outlook PST file. 

  

 

 

 



To select an Outlook Profile: 

 Click on Select Outlook Profile and choose any of the profiles which appear below. 

Or, 

To select an Outlook PST File: 

 Click Select Outlook PST File and locate the MS Outlook PST file you need to convert. 

 After selecting PST file, select Mail client for which conversion is needed. Application supports Thunderbird, 

Spicebird, Netscape and SeaMonkey only.    

 Click OK button to start the conversion process. 



 

3.2. Find PST Files 

You can search for PST files using Find PST File Option in Select Outlook Profile & MBOX Client dialog box. You can 

search for files in drives, folders and sub folders. However, you can select only one drive at a time to search for files. 

To search for PST files: 

 Click Find PST File Option in Select Outlook Profile & MBOX Client dialog box. 

 Find Outlook PST dialog box opens. 

 Select required drive in Look in list box and click Start button to start the conversion process. 

 After the search is finished, list of PST files found in the selected drive is shown in Find Outlook PST dialog box 

as shown below: 

 

 Select file you wish to convert from this list and click OK. 

 Click OK button on Select Outlook Profile & MBOX Client dialog to start the conversion process. 



3.3. Preview of Mails 

You can see the preview of converted mails after successful completion of conversion process. Left pane displays 

selected PST filename under Root node in a tree like structure. Upper right pane displays the list of converted mails. To 

see content of desired mail, click on it in upper right pane. The content is displayed in lower right pane as shown below. 

  

 



 

3.4. Save Converted Mails 

To save converted mails 

 Click Convert to MBOX button on the toolbar or select Convert to MBOX option in the File menu. 

 Stellar Converter for Outlook dialog box opens as shown below. 

 

 To save converted mails, select location for saving MBOX files and click OK. 



3.5. Import Converted MBOX Files 
 
To import MBOX file in Thunderbird: 

Windows 7 / Windows 8 / Windows 10 

 Copy the saved converted mails to the given file path:  C:\Users\Administrator\AppData\Roaming\Thunderbird\ 

Profiles 

 Run Thunderbird. 

 The converted mails appear in the left pane, under Local Folders. 

  

To import MBOX files in SeaMonkey: 

Windows 7 / Windows 8 / Windows 10 

 Copy the saved converted mails to the given file path: C:\Users\Administrator\AppData\Local\Mozilla\ 

SeaMonkey\Profiles 

 Run SeaMonkey. 

 Click on Window in the Menu bar and then select Mail & Newsgroups. Alternatively, you can click  (Mail & 

Newsgroups)  on the left of the Statusbar. 

 A new window opens up and the converted mails appear in the left pane, under Local Folders. 

  

To import MBOX files in Spicebird: 

Windows 7 / Windows 8 / Windows 10 

 Copy the saved converted mails to the given file path: C:\Users\Administrator\AppData\Local\Spicebird\ Profiles 

 Run Spicebird. 

 Click on the Mail,News tab at the top. 

 The converted mails will appear in the left pane, under Local Folders. 

  

To import MBOX files in Netscape: 

Windows 7 / Windows 8 / Windows 10 

 Copy the saved converted mails to the given file path: C:\Users\Administrator\AppData\Local\Mozilla\Profiles 

 Run Netscape. 

 Click on Window in the Menu bar and then select Mail & Newsgroups. Alternatively, you can click  (Mail & 

Newsgroups)  on the left of the Statusbar. 



 

 A new window opens up and the converted mails appear in the left pane, under Local Folders. 

Note: In case you are not logged into your computer through the Administrator account, you will need to change 

Administrator in the given file path C:\Documents and Settings\Administrator\Application Data\Mozilla\Profiles  with your 

user name. 



3.6. View and Save Log Report 

Log Report window displays beginning of the process, end of the process, name of the file etc. during running of the 

process. With Stellar Converter for Outlook, you can view and save Log Report to analyze the conversion process at a 

later stage. 

To view log details, click View Log in View menu on the menu bar. Log Report window opens as shown below. 

  

 

  

 Click Save Log button to save the log report. Enter file name and choose destination in Save As dialog box. 

 Click Clear Log button to clear Log Report window. 

 Click Close button to close Log Report window. 

 

 

 

 

 



 

4. FAQs 

1. What does the demo version of the software do? 

In demo version of Stellar Converter for Outlook, you will be able to view the complete mail body but cannot open 

attachments. To view / save all data and open attachments, you need to purchase and register the software. 

2. What is MBOX file format? 

The MBOX file is the most common format for storing email messages on a hard drive. All the messages for each 

mailbox are stored as a single, long, text file in a string of concatenated e-mail messages, starting with the From 

header of the message. 

An MBOX is a text file containing an arbitrary number of e-mail messages. Each message consists of a postmark, 

followed by an e-mail message formatted according to RFC 822. The file format is line-oriented. Lines are separated 

by line feed characters (ASCII 10). A postmark line consists of the four characters From, followed by a space 

character, followed by the message's envelope sender address, followed by white space, and followed by a time 

stamp. The sender address is expected to be an addrspec as defined in appendix D of RFC 822. 

The date is expected to be formatted according to the syntax represented in the augmented Backus-Naur formalism 

used by RFC 822. 

3. What are the email clients that create MBOX file? 

Program(s) that create .MBOX files are Thunderbird, Spicebird, Entourage, Pocomail, Eudora, AppleMail, Mulberry, 

SeaMonkey, Netscape, ClawsMail, OperaMail, MozillaMail, Evolution, and Sylpheed files. 

4. Can I convert a single mail into MBOX file? 

You can only convert a complete mailbox. 

5. If the location of PST files are not known, can I search for then using Stellar Converter for Outlook? 

Yes, Find File option of the software lets you search for MBOX files in specified drive of the computer. To know how to 

use this option, please refer Find PST Files topic of help manual. 

6. Can I convert multiple PST files simultaneously? 

You can only convert a single PST file at a time. 

 


